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1. Implémentations des services web
1.1. Généralités

Il existe plusieurs implémentations des services web qui facilitent leur développement selon la technologie utilisée. Historiquement, on peut considérer qu’il y avait deux implémentations majeures :
· Axis pour le monde Java 

· .Net pour le monde Microsoft

Dans le monde java, on a plusieurs Framework de seconde génération :
· Axis2 : successeur de Axis 

· JAX-WS successeur de JAX-RPC. Il s’agit de l’implémentation de Sun 

· EJB : c’est principalement JBoss


L’ensemble de ces Frameworks permet à la fois :
· une considérable simplification de la programmation 

· une nette augmentation des performances et de la montée en charge 

· de nouvelles fonctionnalités afin de mieux prendre en compte la norme des services web
La communication entre un client et un Service Web est normée : un client pourra appeler n’importe quel service web indépendamment des technologies sous jacente.

En revanche, la mise en œuvre d’un client ou d’un serveur de service web est très dépendante du choix de l’implémentation et donc du Framework.
Une partie du code métier peut être commune, les mécanismes d’appel peuvent également être rendu standard afin de ne pas trop impliquer le code métier, mais il arrive un moment quand on utilise des objets communs à plusieurs messages, qu’on souhaite gérer des sessions ou tous simplement gérer intelligemment l’accès à la base de données, le code utilisé devient spécifique au Framework choisit.

1.2. Apache Axis
Axis (Apache eXtensible Interaction System) est un des projets de Apache destinés au web service, c’est le successeur de Apache SOAP qui est une implémentation de protocole SOAP (Simple Object Access Protocol). 

Axis est disponile à l'adresse http://xml.apache.org/axis. Dans l'archive téléchargée, on y trouve un package qui fournit : 

· Un environnement pouvant soit fonctionner comme un serveur SOAP indépendant soit comme un plug-in de moteur de servlet (en particulier TOMCAT). 

· Une API pour développer des services web SOAP RPC ou à base de message SOAP 

· Le support de différentes couches de transport : HTTP, FTP ... 

· Des outils pour déployer, tester et monitorer des services web

· Des outils pour créer automatiquement les WSDL correspondant à des classes Java ou inversement pour créer les classes Java sur la base d'un WSDL (classe proxy en quelque sorte, qui fait le lien entre l'application Java cliente et le service distant. 

Apache a sorti une nouvelle version Axis2 qui est une réimplémentation de Axis dont le but est d'être plus flexible et plus adaptable.
Eclipse fournit à travers son outil WTP (WebTools Project) les éléments nécessaires au développement de services web avec Axis :
· création de WebServices à partir de classes Java ou d'EJB (approche 'Bottom-up'). 

· génération de l'implémentation Java d'un WebServices à partir d'un fichier WSDL (approche 'Top-down'). 

· génération de classes clientes Java pour invoquer un WebServices 

· déploiement et test des WebServices. Possibilité de visualiser le détail des échanges SOAP en utilisant le 'TCP/IP Monitor'. 

· édition des fichiers WSDL (édition du code source ou édition visuelle). 

· validation des fichiers WSDL. 

Nous ne détaillerons que les aspects de développement 'Bottom-up' et 'Top-down'.
1.3. Création de service web à partir d’une classe java

Pour développer un service web Axis à partir d’une classe java il faut suivre les étapes suivantes :

1. Téléchargez la distribution binaire d’ Axis2 disponible au http://ws.apache.org/axis2/download.cgi . Ensuite, déclarez celle-ci dans WTP en allant sur Window->Preferences->Web Services->Axis2 Preferences, et sélectionnez le chemin où vous avez extrait Axis2 : 
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Fig.1
2. Créez une application web et sélectionnez les options d’Axis2 lors de la création : 
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Fig.2

Ensuite, cliquez sur Terminer.
3. Créez une classe java qui fournira les méthodes que votre service web exposera. Prenons l’exemple d’une classe qui permet de convertir une température en Celsius et en fahrenheit :
package wtp;

public class Converter

{

  public float celsiusToFarenheit ( float celsius )

  {

    return (celsius * 9 / 5) + 32;

  }

  public float farenheitToCelsius ( float farenheit )

  {

    return (farenheit - 32) * 5 / 9;

  }

}
4. Cliquez droit sur la classe et sélectionnez File -> New -> Other... -> Web Services -> Web Service  
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Fig.3
Cliquez sur suivant :
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Fig.4
Cliquez ensuite sur Web service runtime et sélectionnez Axis2 :
[image: image5.png]& Service Deployment Configuration

Choose from the lst of runtimes and deployment servers, or use the defaut settings.

Server-sid Deployment Selection
O Chooss server first

(@ Chooss Web service runtime first

OExplore options

‘ieh service runtime:

Apache fxis

Server

& Exsting Servers
i Tomcat v6.0 server at locahost
B server Types





Fig.5
5. Cliquez sur suivant et laissez les options par défaut :
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Fig.6

Ensuite, sélectionnez Start Server et cliquez sur Terminer :
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Fig.7
6. Déployez maintenant votre application sur le serveur Tomcat : cliquez droit sur le projet, séléctionnez Run -> Run As -> Run on Server et cliquez sur terminer.
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Fig.8

Ce qui permet d’afficher la page d’accueil de votre service web :
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Fig.9

Le lien Service permet d’afficher tout les services déployés avec leurs URL d’accès et les méthodes qu’ils exposent :
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Fig.10
Cliquez sur le service, exemple Converter, pour visualiser le descripteur WSDL :
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Fig.11
Maintenant, on va générer un client pour le service web Converter à travers son fichier WSDL.
Mais avant il faut clarifier certains points :

· Un Web Service Stub est une classe java qui donne un accès local aux méthodes du service web. Le Stub masque tous les appels aux méthodes nécessaires à l'invocation du service web et masque donc toute la complexité liée à l'invocation distante, la propagation de la sécurité... liée à l'utilisation du service web. Il faut juste l’importer dans l'application client et utiliser les interfaces présentes dans ce Stub. 
· On n’a pas besoin des librairies d'Axis pour consommer le web service, c'est seulement le serveur déployant le web service qui doit les contenir.
7. Cliquez sur File -> New -> Other... -> Web Services -> Web ServiceClient, ensuite copier l’URL du service web de sa définition (Fig.11) :
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Fig.12
Renseignez le nom du client en cliquant sur le lien Client project et cliquez sur suivant :
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Fig.13
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Fig.14

Le client est ainsi généré avec toutes les classes nécessaires à l’appel du service Converter :
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Fig.14
8. Créez une classe ConverterClient qui instancie l’interface du Stub du service et qui fait appel à sa méthode de conversion :
package wtp;

import java.rmi.RemoteException;

import org.apache.axis2.AxisFault;

import wtp.ConverterStub.CelsiusToFarenheit;

import wtp.ConverterStub.CelsiusToFarenheitResponse;

public class ConverterClient {

        public static void main(String[] args) {

                try {

                        float celsiusValue = 100;

                        ConverterStub stub = new ConverterStub();

                        CelsiusToFarenheit c2f = new ConverterStub.CelsiusToFarenheit();

                        c2f.setCelsius(celsiusValue);

                        CelsiusToFarenheitResponse res = stub.celsiusToFarenheit(c2f);

  System.out.println("Celsius : "+celsiusValue+" = "+"Farenheit:"+res.get_return());

                } catch (AxisFault e) {

                        e.printStackTrace();

                } catch (RemoteException e) {

                        e.printStackTrace();

                }

        }

}

9. Exécuter la classe ConverterClient comme application java : Run As -> Java Application. Le résultat devrait s’afficher sur la console :
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Fig.15
1.4. Création de service web à partir d’un descripteur WSDL
Cette méthode consiste à reproduire les classes métier du service web à partir de son fichier de description. Pour cela, reprenez les étapes 1 et 2 du paragraphe précédent. Ensuite suivez les étapes suivantes :

· Créez un dossier /wsdl et placez y votre fichier de description. Voici un exemple :

<?xml version="1.0" encoding="UTF-8"?>

<wsdl:definitions xmlns:soap="http://schemas.xmlsoap.org/wsdl/soap/" xmlns:tns="http://tempuri.org/AreaService/" xmlns:wsdl="http://schemas.xmlsoap.org/wsdl/" xmlns:xsd="http://www.w3.org/2001/XMLSchema" name="AreaService" targetNamespace="http://tempuri.org/AreaService/">

  <wsdl:types>

    <xsd:schema targetNamespace="http://tempuri.org/AreaService/" xmlns:xsd="http://www.w3.org/2001/XMLSchema">

      <xsd:element name="area" type="xsd:float"/>

      <xsd:element name="parameters" type="tns:dimensions"/>

      <xsd:complexType name="dimensions">

      
<xsd:sequence>

      

<xsd:element name="width" type="xsd:float"></xsd:element>

      

<xsd:element name="height" type="xsd:float"></xsd:element>

      
</xsd:sequence>

      </xsd:complexType>

    </xsd:schema>

  </wsdl:types>

  <wsdl:message name="CalculateRectAreaResponse">

    <wsdl:part element="tns:area" name="area"/>

  </wsdl:message>

  <wsdl:message name="CalculateRectAreaRequest">

    <wsdl:part element="tns:parameters" name="parameters"/>

  </wsdl:message>

  <wsdl:portType name="AreaService">

    <wsdl:operation name="CalculateRectArea">

      <wsdl:input message="tns:CalculateRectAreaRequest"/>

      <wsdl:output message="tns:CalculateRectAreaResponse"/>

    </wsdl:operation>

  </wsdl:portType>

  <wsdl:binding name="AreaServiceSOAP" type="tns:AreaService">

    <soap:binding style="document" transport="http://schemas.xmlsoap.org/soap/http"/>

    <wsdl:operation name="CalculateRectArea">

      <soap:operation soapAction="http://tempuri.org/AreaService/NewOperation"/>

      <wsdl:input>

        <soap:body use="literal"/>

      </wsdl:input>

      <wsdl:output>

        <soap:body use="literal"/>

      </wsdl:output>

    </wsdl:operation>

  </wsdl:binding>

  <wsdl:service name="AreaService">

    <wsdl:port binding="tns:AreaServiceSOAP" name="AreaServiceSOAP">

      <soap:address location="http://tempuri.org"/>

    </wsdl:port>

  </wsdl:service>

</wsdl:definitions>

Eclipse offre une vue Design qui permet de visualiser graphiquement les éléments du fichier:
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Fig.16
· Cliquez droit sur votre fichier wsdl File -> New -> Other... -> Web Services -> Web Service :
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Fig.17
Et cliquez ensuite sur web service Runtime pour sélectionner Axis2 :
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Fig.18
· Cliquez ensuite sur suivant, et laissez les options par défaut. Ce qui permet de générer le Skeleton Bean qui contient toute les méthodes décrites dans le wsdl avec leurs déclarations :
[image: image20.png]& Web Service

Axis2 Web Service Skeleton Java Bean Configuration

Select the apprapriate cads generation settings

Service Name. Areaservice

Port Name AreaserviceSOAP

Databinding 208

Custom packags name | org tempuri areaservice

[Jenerate an interface for the skelston

[Jenerate all types for all elements referred by schemas

Nemespace Package
hitp:Jtempur org/éveaservice] orgtempuni areaserice
Retpfunn 3. orgf2001 XML Schema org.n3. . _2001 lschema
http:jschemas xtlsoap.orgfwsdsoap/ orgcnlsosp.schemas.wsdl.soap
Petprfjschemas xmisoap. orgfwsdl] org.xmlsosp.schemas.wsdl





Fig.19
· Après, cliquez sur le bouton Start server et sur Terminer.
Eclipse génère les classes java du service web dont le Skelton, auquel il faut rajouter l’implémentation des méthodes générées :
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Fig.20
Pour cela rajoutez à la méthode CalculateRectArea le code suivant :
org.tempuri.areaservice.Area area = new org.tempuri.areaservice.Area();
area.setArea(parameters.getParameters().getHeight()*parameters.getParameters().getWidth());

return area;
Ce qui permet d’instancier un type de retour Area et de l’initialiser avec le produit des deux paramètres d’entrés (calcule d’une surface).

· Exécutez votre services web sur le serveur Run -> Run As -> Run on Server et acceptez les paramètres par défauts:
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Fig.21
· La page d’accueil du service web apparaît avec ces informations et les méthodes qu’il publie :
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1.5. Test des services web
L’outil WTP (Web Tools Platform) d’Eclipse fournit le Web Service explorer qui permet de tester les services web.
Pour L’utiliser cliquez droit sur le fichier WSDL du service web et sélectionnez web services ->Publish WSDL file et cliquez sur terminer :
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Ensuite, sur la vue de l’explorer sélectionnez l’icône WSDL page :
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Fig.25
Renseignez l’adresse de votre service web, et cliquez sur GO :
http://localhost:8080/ExempleWS2/services/AreaService?wsdl
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Cliquez sur la méthode CalculateRectArea, renseignez les paramètres et cliquez sur GO :
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Ceci permet d’invoquer la logique métier de votre service web avec une liaison SOAP.

2. Sécurité des services web (WS-Security)
Il y a aujourd’hui en production de nombreuses applications mettant en oeuvre des services Web qui basent leur sécurité sur les mécanismes standards liés aux protocoles de transport sous-jacents :
· SSL (Secure Socket Layer) : protocole conçu pour assurer la confidentialité des échanges entre un client et un serveur Web, sur différents protocoles de transport (en général, HTTP)
· IPSec (IP Security Protocol) : protocole de sécurité réseau faisant partie intégrante de la pile IP utilisé entre deux serveurs ou deux « passerelles de sécurité » (tout système intermédiaire qui implémente IPSec) ou entre un serveur et une passerelle afin de sécuriser les sessions en offrant des mécanismes d’authentification, d’intégrité et de confidentialité des données

Ce modèle de sécurité est un modèle simple, adapté aux solutions pour lesquelles les mécanismes de transport et la configuration des points de terminaison sont complètement maîtrisés (notamment sur les scénarios de type intranet).
Cependant, quelles sont les limites d’une telle approche pour garantir l’intégrité et la confidentialité des messages ?
HTTPS permet le chiffrement et la signature du message, ainsi que l’authentification de l’appelant, ce qui permet de garantir la non répudiation, la confidentialité et l’intégrité des informations échangées. Mais dans certains contextes, cela se révèle insuffisant pour plusieurs raisons :
· Le protocole SOAP n’est pas exclusivement lié au protocole HTTP 

· Il peut résulter une dépendance vis-à-vis de la plate-forme et du fournisseur de service de sécurité (NTLM, Kerberos...) 
· La topologie d’une solution distribuée fondée sur les services Web peut inclure de nombreux périphériques ou systèmes intermédiaires. Il est donc primordial de pouvoir sécuriser les échanges entre application et services transitant entre ces noeuds intermédiaires. Dans ce type de configuration, le protocole HTTPS ne gère qu’une sécurité de point à point (avec potentiellement une clé de session modifiée à chaque étape), pas de bout en bout. Comment faire alors pour maintenir le contexte de sécurité sur la globalité de la chaîne ?
En résumé, la sécurité n’est garantie que par la plate-forme et le transport :
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Fig.28
WS-Security est une spécification initiée par Microsoft IBM et Verisign qui indique comment utiliser XML Encryption et XML Signature, ainsi que Kerberos ou des certificats dans les en-têtes et extensions de messages SOAP pour les signer et les crypter. C'est donc la brique fondamentale de la sécurité des services Web. Conçue de façon modulaire, elle prévoit d'intégrer d'autres spécifications, qui garantiront l'intégrité, la confidentialité, l'authentification et la non répudiation des échanges. 
En se fondant sur une sécurité de niveau messages, WS-Security permet de sécuriser une solution mettant en oeuvre une multiplicité de plates-formes, sans nécessité d’avoir la maîtrise de la configuration des différents noeuds extrémités ou intermédiaires intervenant dans l’échange et en offrant des compléments en termes de chiffrement et de non répudiation.
Dans ce modèle de sécurité, les messages XML contiennent les informations d’identification, les signatures numériques qui peuvent être chiffrées :
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Ainsi, un ensemble de « SOAP extensions » standards qui implémente la sécurité (intégrité et confidentialité) est défini. 
Plutôt que de proposer un nouveau Framework de sécurité, WS-Security s’inspire des mécanismes existants permettant la mise en place d’une infrastructure sécurisée et propose trois mécanismes constituant un socle flexible de protection des services Web :
· La transmission de jeton de sécurité par des mécanismes standards d’encodage et d’inclusion de jetons binaires de sécurité au sein du message SOAP et fondés sur un modèle auto descriptif et extensible. En effet, les caractéristiques de ces jetons y sont présentes et de multiples formats peuvent être utilisés : couple utilisateur/mot de passe, certificats X.509 v3, tickets Kerberos, jetons XML : SAML, XrML.
· La signature numérique des messages pour assurer leur intégrité en vérifiant par cryptographie que le message SOAP n’a pas été altéré depuis qu’il a été signé en se fondant sur le standard XML Signature, défini par le W3C. Pour signer le message SOAP, l’émetteur a besoin de sa clé privée et pour que le récepteur puisse vérifier la signature du message SOAP, il a besoin de la clé publique de l’émetteur :
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· Le chiffrement de ces messages afin de garantir la confidentialité des échanges en se fondant sur le standard XML Encryption défini par le W3C. Le chiffrement du message SOAP crée un secret cryptographique qui est partagé avec le destinataire du message. Pour chiffrer le message SOAP, l’émetteur a besoin de la clé publique du destinataire, et le récepteur a besoin de sa clé privée pour déchiffrer le message :
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Chacune de ces fonctions peut être utilisée séparément ou s’associer pour adresser de nombreux scénarios d’architecture de services sécurisés infrastructure à gestion de clés publiques [PKI], Kerberos). WS-Security ne définit pas les méthodes de chiffrement (XML Encryption) ou de signature des messages (XMLSignature), mais comment incorporer les informations spécifiques à ces standards dans l’en-tête d’un message SOAP. En outre, cette spécification permet de définir les mécanismes de transmission de multiples jetons de sécurité, à travers de multiples domaines de confiance, en utilisant de multiples formats de signature et de chiffrement.
Pour véhiculer les informations de sécurité, WS-Security définit donc une entête générique pour le message SOAP indépendant du mécanisme de sécurité mis en oeuvre. Cet en-tête doit pouvoir héberger plusieurs jetons de sécurité permettant d’identifier l’appelant, des informations sur la manière dont le message a été signé ou chiffré et des informations pour localiser la clé (contenue ou pas dans le message).
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